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OHREM Instrument Guide 

Basics 
There are 3 major components to the OHREMs operation which is important to understand. The X axis, the Z axis and the 
optics all of which are constant on all Optical HREM instruments (Micro/Ultra/Revision 1). 

 

Figure 1 X and Z stage 

X Axis  
The X axis is the axis that carries the blade and is moving in the horizontal direction to position the blade back and forth.  

Z Axis  
The Z axis will hold the sample, incrementally moving the block up with each full movement of the X axis.  

Optics  

 

Figure 2 Optic Setup 

The optics consist of an Olympus MVX10/Leica Z16 Apo/Compound arrangement, placed upon either a manual or 
automated XY stage. 

Filters 

Some systems will contain filters, these filters filter the light on the excitation (light source) and emission (camera). These 
filters restrict wavelength ranges. It is worth checking the configuration and filter positions.  
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Light Sources 

Some systems have LED configurations (such as the CoolLED PE-300,PE-400,PE-800) for specific wavelength excitation or 
white light systems that only have on an off toggles of a halogen (or similar) bulb. Users will have to pair the correct light 
sources with the correct filters. 

Peripherals 

OHREM Revision 1 
The fan is situated at the back of the unit and can be used to force incomplete specimen cuts off of the block and into the 
vacuum supplied with the machine. The fan can be turned on by pushing the black button at the front of the system. This 
switch may be round or square. 

 

Figure 3 Revision 1 Fan Button 

OHREM Revision 2 (Ultra & Micro) 
Revision 2 has a fan situated underneath the lid of the unit that cannot be adjusted, it sits here to give perfect air flow. In 
order to turn this on or off use the button switched to the left of the unit located just below the emergency stop. The micro 
has a similar setup, and you can identify the buttons in a similar way. 

 

Figure 4 Revision 2 Fan Button 
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XY Controller/Fine Focus Controller 

 

Figure 5 XY Controller 

The Indigo XY/Focus Controller sits in a small compact black and white box. There are 3 buttons at the front of the joystick 
that control simple commands from within the Acquire software only. 

1. The button on the far left is the lock/unlock button, this button will stop all readings from the controller from 
moving the XY/Focus at the controller level. This will signal a buzzer noise from within the control box once for lock 
and twice for unlock. During an experiment/prepare this will automatically be locked and then unlocked after and 
experiment.  

2. The second switch moves the Z Down by the small step labelled in the acquire software NOTE: this can only be 
done from within the acquire software. (This button can also be configured to move the fine focus up). 

3. The third switch, furthest to the right, moves the Z Up by the small step labelled in the acquire software. NOTE: 
This can only be done from within the acquire software. (This button can also be configured to move the fine focus 
down). 

Moving the controller in the X and Y direction will move the XY. Twist the knob assembly to use the motorized focus. Do not 
be alarmed by the noise this is just the motor and is normal. The XY will need to be origin searched with each power cycle 
or computer restart. The controller is powered by the PC however the motors are powered by the power source. To adjust 
the speed of both please use the acquire software and go to the XY tab where there will be a set of buttons labelled low 
speed, mid speed, and high speed. Press these to update the speed of the controller. 

Setup and Run 

Power Up 
Before using the machine ensure the machine is switched on, this will be indicated by a Red neon light at the back of the 
machine on the power inlet. The illustration shows what to expect. To turn off toggle the switch, the neon light should dim 
after 5 seconds. 

 

Figure 6 Power Switch 
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Loading a Specimen 

1. Z axis must be lowered, and X axis set to the origin for the users’ safety.  
2. Begin by opening the jaw of the sample holder by unscrewing the screw. Rotate in the Anti Clockwise direction 

until the sample can fit in the space.  
3. Place the specimen in the circular space.  
4. Begin to tighten the specimen by rotating the screw in a clockwise direction. Ensure the specimen is held tightly 

however, stop when the hex key cannot be rotated without excessive force. Over tightening the sample can lead to 
complications. 

5. The sample has been successfully loaded into the machine. 

 

Changing the Blade 

 

Figure 7 Illustration of Blade Holder 

Removing the Blade 

To remove a blade, unscrew the holding screws, hold your hand with NO pressure underneath the blade to ensure it does 
not fall. It is recommended that the screws are loosened slightly prior to them being relaxed to a point the blade falls. 
When the blade splits from the holder, place in a secure box.  

Installing a Blade 

 Hold the blade in the palm of your hand and grip the edge of the blades flat surface. Place the blade into the holder on the 
side you are holding and tighten the screws on the associating side. Then proceed to pull the other side from the flat side. 
Then tighten this side. Ensure all screws are tight. 

Utilising Blade Surface 

A poor blade can produce lines on the specimen, in order to get the most from the blades it is optimal to utilise the whole 
of the blades surface. To use alternative parts of the blade the specimen holder can be moved by unscrewing the holder 
and moving it along the dovetail on top of the Z stage. 
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Bringing Block to Blade 
Bringing the block to the blade can be a daunting task for a new user, but after a few attempts it will come naturally and 
you will find your own way of performing this. We have laid out some simple ways to perform this, please read the X stage 
and Z stage operations from the software guide to help. 

Paper Method 

 

Figure 8 Block Blade Illustration 

The paper trick is an easy, introductory way to bring the blade up to the sample. It should be avoided for prolonged use as 
debris from the paper can cause blade lines, see visual method for an alternative advanced method. The sample will need 
to be brought to the blade to cut. To do so go to the Z stage instrument control panel and move the Z up with the given 
controls. Follow the following instructions:  

1. Bring the X Stage to above the specimen (making sure the Z Stage is not near the blade).  
2. Using the Z Stage controls move the blade up, starting with large move down to medium. Once the sample is 

almost touching the blade slide a piece of paper under the blade. 
3. While the piece of paper is between the blade and the sample bring the Z stage up, when the piece of paper 

cannot move from underneath the blade (it is trapped between the sample and the blade), move the Z down by 20 
microns. Start a prepare until sections are being cut. 

Visual Method 

 

Figure 9 Visual Method Illustration 

The visual method does not require a piece of paper but a keen eye. The sample will need to be brought to the blade to cut. 
To do so go to the Z stage instrument control panel and move the Z up with the given controls. Follow the following 
instructions: 

1. Bring the X Stage to above the specimen (making sure the Z Stage is not near the blade).  
2. Using the Z Stage controls move the blade up, starting with large move down to medium. Once the sample is 

almost touching the blade move to visualise the blade. This will give the user a visual of the light between the 
blade and the sample.  

3. Continue to move the blade up inclemently until no visible light is seen between the blade and the sample, at this 
point start a prepare and wait for the block to cut. 
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Rotating FOV/Camera  
Some systems have the ability to move the camera, you may want to move the camera to fit the object unit he field of view. 
It is worth noting that for stitching you need the camera parallel to the XY axis. 

The camera screw is located above the fluorescence illuminator, below the tube lens. The tube lens may be different 
dependent on the type of system you have.  

• Locate the screw (highlighted below) 

• Find a hex key (M4) and insert into the highlighted hole  
• Screw to the left to un-tighten, holding onto the tube lens to ensure it does not fall. When the tube becomes loose 

rotate it to the desired position.  
• Tighten the screw by going anti clockwise until tight. 

Microscope Zoom  
If you have an MVX microscope or Z16Apo you will be able to zoom the optics to fit the area of your sample. The zoom is 
located on the side of the microscope and can be adjusted by rotating, the smaller the number the lower the zoom (bigger 
the field of view).  
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Calculating Image Dimensions 

This is the method to calculate the image dimensions in the real world, for this you will need a graticule. It is suggested to 
go through each zoom step 0.63x, 0.8x to get the zoom at each point but not required. 

• Put the Zoom of the microscope down to the desired zoom and focus. (THE FOLLOWING IS NOT ACCURATE USE 
JUST FOR METHOD). 

• Place a graticule under the microscope, on a sample.  

 

• Take a shot in the resolution you would capture in (full resolution). 
• Click ‘Calibrate’ in the virtual graticule. 

 

• Select a known distance in this case the distance between the two bars is 1mm. Use the left-hand mouse 
button to start the calibration and the right hand mouse button to set the end. 
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• Now a prompt will appear set this to the known distance as below and click ok. 

 

• Now we now the dimensions of the image 

 

• To see the pixels per micron go to the virtual graticule tab, this means that there is 0.50572 pixels per micron. 
Therefore given image has the following properties: 

o Width(px): 1232 Height(px):1028 
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o Width(microns):2436.1246 Height(microns):2023.7403 
o Pixel size = 1/0.50572 = 1.977 microns So each pixel is 2 microns wide. 

 

 

Emergency Stop 

The emergency stop cuts power to the system immediately, this stops the X and Z stage. Use this in an emergency 
regarding the system, such as possibility of user harm. 

The emergency stop can be activated by pushing in the stop. 

When the situation is rectified, twist the red knob to release the activated switch. Only then will it reset. 
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Common Issues 
• Block Issues. 

o Soft blocks – soft blocks will compress when squeezed and deform, this kind of block cannot be 
sectioned well and can experience issues such as breakage. Symptoms include: 

▪ Movement in capture during a run. 
▪ Can be squeezed or manipulated by a user. 
▪ ‘Wobbly’ lines in the image in the resin. 
▪ Poor quality 3Ds where the Z axis moves. 

o Hard blocks – although more likely to section than soft blocks can shear off the chuck. These blocks tend 
to break more due to adhesion to a chuck. Symptoms: 

▪ Breaking but no evidence of wobbling. 
▪ Skipping of the blade over the surface of the block. 

o Blocks breaking 
▪ Ensure all screws are tight. 

o JB4 Issues – DO NOT USE JB4 PLUS, use standard JB4. 
• Instrument Issues 

o Errors  
▪ Multiple errors – It is unlikely that multiple errors will occur, in this case it is worth checking 

power is on and the emergency switch on the unit is released. 
▪ Single errors – In this case turn off the item and turn it back on, then close the software and open 

again and then try again. 
▪ During an experiment – If an error occurs, ensure you notify the Indigo team as well as ensure no 

IT updates/events have occurred. 
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OHREM Software Guide  

Introduction 
This manual is written to cover the basics as a quick start guide for OHREM Acquire software, this is for version 1.8.16.  

Opening the software  
OHREM software is called ‘OHREM Acquire’ open this software using the icon on the desktop, toolbar or start menu. 

 

Figure 10 Acquire Icon 

Connection Status Window  
The connection status window appears when you enter the software. This window is an efficient way of origin searching 
multiple devices easily. When this appears select ‘origin’ under each device that needs it. There is no need to origin search 
the Z stage. 

• Open each drop down like below.  
• Read what is being asked by the software, for all systems the X stage will need to be origin searched, press go.  
• If you have filters and a XY stage, these will also need to be origin searched.   

 

Figure 11 Connection Status Window 

To re-open the panel, go to tools -> connection window. Or right click the instrument status expander. 

 

Figure 12 Connection Status Right Hand Click 
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Layout 

Experiment/Settings 
Use the experiment/settings tabs to operate the experiment and experiment settings. The settings tab for altering 
application settings. 
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Instrument Status 

 

Here is the status of all the devices the HREM has, use the disconnect and connect buttons to connect and disconnect 
from the unit.  

Errors 

 

If an error appears I this window, first make sure everything is connected and on. Second try a low level retry using the 
button ‘Retry’. If this does not work come out and back in the software. Beyond that contact us for help. 

Home 

Use the homing buttons on the X and XY stage in the connection window to origin search these two devices quickly. An 
origin search helps the device understand where ‘Home’/0 is. 
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Current Run Images 

 

Figure 13 Current Run Images 

View current run images in the tab next to ‘Current Images’, while the experiment continues view all the experiment data 
easily. Use the slider to adjust to the image you would like to view in the stack or use the ‘Next’ and previous buttons. Use 
the drop down of image folder to select the current image profile.  

• You can right click on the images to get some more options such as opening the folder the experiment is in. 

NOTE: Images and number of images will only update when on the tab and after the 1st section. 
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Manual control and loading sample.  

X Stage  
The X Stage controls the movement of the blade, use this tab to setup the movement during an experiment as well as 
control the blade outside of the experiment.  

Sequence Setup 

 

Figure 14 Flow of X Stage Movement in Experiment and Prepare 

 

Figure 15 Sequence Setup 

• Home – Is the starting position of the blade. 
• Pre-cut(optional) –position before the sample. 
• Cut (optional) –position the blade will begin the cut sequence. 
• End – The end position of the blade at the end of the sequence. 
• Use the go buttons to move between the positions manually. 
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Manual Control  

Control Box 

 

Figure 16 X Stage Control Box 

• Run once – Run the sequence once. (Home -> Pre-Cut -> Cut -> End -> Home) 
• Repeat – Repeat the sequence, this is what you want to run and then move up the Z.  
• Repeat Until Stop Press -> (Home -> Pre-Cut -> Cut -> End -> Home) 
• Stop – Stop the current sequence. 
• Origin search – Origin searches the motor. 
• Quick move – move the motor to a specific position, put a value in this box and press go to move. Replaces the old 

manual tab on the old software. 
• Fast Stop – Immediately powers down the motor NOTE: this will give an error from the motors that needs a 

software restart. 

Shuffle 

Use the arrows to shuffle the stage backwards and forwards using the arrow, it will move by the value in the middle. 

 

Figure 17 X Stage Shuffle 

Manual moves the x stage relative to the current position.  

• Press the right button the X Stage moves right by the value in the middle. 
• Press the left arrow the button moves the X stage to the left by the value in the middle.  
• Press ‘Set as end’, it will set the CURRENT X Stage position to the end position in the sequence. 
• Press ‘Set as Home’ it will set the CURRENT X Stage position to the home position in the sequence. 

SHUFFLE WILL NOT ALLOW USERS TO GO TO OR BELOW 0, IF A VALUE IS ENTERED THAT WILL DO THIS IT WILL 
IGNORE THE COMMAND. 
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Z Stage 
Use the Z stage controls for control of the Z outside of an experiment. Use the small medium and large moves to move the 
sample up and down.  

 

Figure 18 Z Stage Tab 

All small step, medium and large step are relative modes. This means they move in relation to the current position. For 
example, if you move 3 microns up in the small step this would be your current position +3 microns. Absolute positioning 
moves the Z to a specific value, for example if you move to 5mm the Z will move to what it believes 5mm of the bottom of 
the Z is.  

• Small step – move the sample up and down by under 20 microns.  
• Medium step – move the sample up and down above 20 microns.  
• Large step – move the sample up and down in millimetres. 
• Move absolute – move the Z to a specific position. i.e. if I want to 5mm. 

Some models will have the option to move absolute. Others this feature was removed to avoid confusion of the 
function. 
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XY Stage 
The XY stage can make the system more complex to run, but following the instructions and guides below should help any 
user understand modes better. 

Modes 
The XY Stage has multiple modes for setting up and experiment, these change the way the instrument behaves during an 
experiment. The XY mode can be changed by using the drop down in the XY stage tab. 

1. Still  

This will perform an experiment without moving the XY, treat this mode like you do not have an XY and simply move the 
XY to the desired imaging position and press run. 

In this mode you can run one block with multiple image profiles, for example with multiple fluorescence with just one 
shot. 

2. Scanning  

This mode moves the XY in a pattern mode, generating individual images for each section in the desired setup, note: 
the software will not automatically combine images you can do this later with the stitching tools software. 

In this mode you can collect multiple images of the surface in a tiled manner to make a larger, higher resolution image 
with multiple image profiles for each position.  

To set up a stitch follow the instructions below:  

1. Move the XY stage using the manual controls to the bottom right area of the sample. 
2. Set the current position as the home position by pressing ‘Set’.  
3. Select an adequate spacing. This is important as too high, and the image will not be recoverable. For reference 

see the stitching example above. The spacing should overlap each image by at minimum 40 percent of the next 
image.  

4. Select a number of X and Y images to fit in the whole specimen.  
5. Press ‘Calculate’ and the XY positions should fill into the positions box, select a position for the XY to move to this 

position.  
6. To edit the spacing and images ‘Calculate’ must be clicked again. 
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3. Multi Position Single 

this mode moves the XY to specific positions designed to image multiple samples, this is done by creating ‘image 
profiles’ and giving them a position. 

Capture multiple samples with each image profile having an XY position associated with it. Add multiple image 
profiles with the same position to achieve multi fluorescence channels. 

Multi-Position uses the setup image-profiles to move the XY to different positions for each profile. There are a few 
scenarios this is useful in:  

• One block, multi specimens - this is when more than one specimen is placed into the block. Before the XY the 
user would have to compromise on magnification to fit in more than one specimen however, now you can use 
multi-position to create a tailored image for each specimen.  

• Multi block - A new idea comprising of multi specimens in different blocks all being cut in one motion. Use 
profiles to tailor for each block.  

To use multi-position, follow the steps below: 

• Select the current profile to change the position of.  
• Move the XY using the manual controls to the desired position and press the ‘Set to current position’ button.  
• Do this for all positions. It is important to note that when changing the profile, the XY will move the assigned 

position. 

 

4. Multi Position Scanning 

Combine more than one sample with the ability to capture tiles images, combining modes 2 and 3, for each 
fluorescence channel you will have to have a new image profile with the same XY settings as per mode 3. 
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Structured Illumination  
The structured illumination model contains a high precision grating that interrupts the illumination path producing a 
pattern on the surface of the block. Then an algorithm processes the block images to create a clearer image.  

Using the SIM 
Startup  

At startup the SIM will not automatically connect to the camera, this is because they need to be synced in order run if the 
camera is not connected the SIM will not either and vice versa. 

1. Startup the software. 
2. Ensure the Camera and SIM are connected in the instrument status window. 
3. Now press the ‘Sync’ button to sync the two devices. The SIM will perform a movement and then respond if it is 

synced successfully. 

 

Figure 19 Instrument Status Window Before Sync 

How it is Used 

The sim is switched on or off by changing the resolutions of the camera, if it contains the word ‘SIM’ then the SIM will be 
active in this time. Both in live and resolution modes.  

When a SIM mode is selected it will run through the pattern and display the result as would be saved in an experiment. The 
resolutions allow the user to adjust the size of the images, higher computation will take longer. You can expect 20 seconds 
on the full 20 megapixels (dependent on processing). 

Not only can you run SIM you can run normal shot modes in a separate profile by simply selecting it in the shot resolution 
drop down. 
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How to Set Up an Image 

Unlike a typical traditional image you cannot simply capture a SIM image, you will need to ensure the lines are clear in the 
image as below. In this image the block is fluorescing, so the lines are white showing a reaction to fluorescence. 

1. Set the live mode to a non-SIM mode (a mode not containing the word SIM). 

 

2. Run the camera in live mode, the grating will move to the non-SIM position, go to the ‘Structured-Illumination tab 
and select ‘Go’ next to the starting position value selector. 

 

3. The grid will now appear if it does not (It is important to focus on the raw images): 
a. Adjust the exposure to increase the fluorescence intensity on the camera. 
b. Increase the light intensity. 
c. Adjust camera parameters (gamma, contrast, brightness etc). 
d. Check for external light environment affecting the image. 

4. Go back to the camera tab, change the shot resolution to sim shot as below and capture a shot to test the image. 

 

 

 

Figure 20 Raw 1st Position Projection 
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Image Saving 

Images are stored in TIFF files, unlike traditional HREM images the structured light images are saved in multi-page TIFF 
stacks. This is to allow the user to extract the original 3 phase positions.  

1) The RMS image. 
2) Original phase 1 image. 
3) Original phase 2 image. 
4) Original phase 3 image. 

Focus 

Focus is vital to the SIM working effectively, unlike capturing an image you are not looking for a decent live feed image. The 
grating must be equal, this means while setting up the focus must be just right so that the dark and gray areas of the 
grating are perfect.  

Pre-cautions and Notes  
The structured illumination method is extremely sensitive to the following parameters: 

1. Outside fluorescence- unlike conventional HREM imaging the algorithm expects to only see the fluorescence 
returning through the system. When outside light interferes with the image such as lights and monitors, you will 
get this interfering with the pattern causing a low-quality output. 

2. Poor signal and camera parameters- there is an art to this, but you will need to find a suitable camera parameter 
when running SIM, the signal from the sample should be seen but not over saturated. A lower contrast setting 
helps the output, the key is to look at the raw image and assess if you can see the projected pattern clearly.  

3. Focus – When the grating is not in focus the illumination isn’t even between the projected pattern, you will need to 
ensure the camera is in focus. 

4. Noise – The camera gain is important to balance and noise reduction to the actual camera feed, the structured 
illumination algorithm is extremely sensitive to noise. You can use the in-built noise reduction before and after 
processing to help this further. It is best to work on this later, the FastNLMeanDenoising function in opencv works 
well. 

5. Intensity variation – You may notice some variation in intensity from image to image, this is not due to the 
instrument, camera, or light source but due to the resultant structured light calculation. This is down to debris or 
external artefacts showing a response to the light and thus producing an intensity. To ensure this does not happen 
be sure to remove as much debris as possible.  

6. Time – structured illumination takes multiple pictures to produce a result, expected time for an image is 3x the 
exposure of the camera plus overhead for the algorithm to take place. 

7. Before shooting a SIM image be sure to stop a live feed, switching to a shot SIM mode while currently on a SIM 
mode will throw an error from the camera as the system attempts to switch prematurely. 

8. As with most of our suggestions do not attempt to run a scanning multi-channel sim sample as soon as you 
use the unit, it will be overwhelming. Do one SIM and standard channel image then progress, our suggestion 
is to always learn one part of an experiment at a time. You will have your own individual hurdles in terms of 
processing and expectations, and these would be hard to handle in one go. 

A helpful way to look at the SIM is to put the camera into a low-resolution live mode (no SIM) and move the grating until 
visible. Then adjust the image until you are happy with seeing the lines. 

 

Figure 21 SIM Phases with SIM RMS image. 
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Noise Filtering 
Naturally a raw image from the SIM produces noise, it is also common for the grating and ambient light to produce lines. 
These lines are filtered using Fourier Transform filtering.  

 

Figure 40 Fourier Filtered Image 

You will have to do this in a pipeline or manually remove notches, acquire does have an in-built window filter but it is very 
time consuming to perform this during an experiment. If you would like the worlds best image you will have to manually 
segment the image. 

We recommend using Fiji to remove the lines or use OpenCV, we were able to achieve the above by using a feature 
detector and removing the lines by masking the noise spikes as seen. In the above the identification of the noise was easy 
as the frequencies were clearly outside of the centre peak. HREM samples (fluorescent background) produce an 
abundance of light making repeat pattern noise removal easy. 
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CRYO 

Simple Experiment Setup 
Here we take a simple object for CRYO imaging.  

1. Place the chiller module onto the system. 
2. Switch on the CRYO module with a plug in the wall, press the ‘Power’ button to begin the cooling process. It will be 

set to 15 degrees automatically, leave it at this, it will most likely get to -13 degrees max but keep this going. The 
cooler will make a distinctive buzzing noise when active. 

3. The CRYO cooler module does not get fixed into anything, this allows a degree of movement for the piston inside 
and for the Z to move the whole unit slightly.  

4. Attach the CRYO module to the HREM. 
a. Take the whole module and screw onto the Z block, hand tighten each screw and then use a hex key.  
b. Lower the Z down gently so that it has plenty of room. 

5. Now we must wait for the cooling process to begin, we usually expect it to take 
1 hour to 1 and a half hours for the chuck to become completely frozen. The 
CRYO monitor software can be used to log the temperature.  

a. The amount of time the CRYO takes to cool is wholly dependent on the 
surroundings, if your room is 20+ degrees we would expect poor 
performance. In this experiment we turned the air-con on to 18. 

b. Look at your sensor temperatures, this helps with troubleshooting. 
One is on the sample; one is on the cooling device and the other is in 
the ambient air. Look at these to determine where any issues may 
occur. 
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6. Now for sectioning, there are two ways you can do this.  
a. The first one is how we do it, as we aren’t particularly delicate and 

want to just get sectioning. We take our sample (a fly) and place on the 
chuck bed. We then smother it in OCT and wait for the OCT to turn 
white. This method is fast but can lead to not very well-coated 
samples. You can just as easily place a 3D printed ring around and 
pour it in.  

b. The proper way is to make a CRYO sample, freeze it in the traditional 
trays, pour OCT on the sample holder, connect the sample to the 
chuck instantly. Then spray with CRYO spray instantly to ensure your 
sample stays cold.  

7. Now just section as normal, you kow your ready to go when the OCT turns to a 
white colour rather than transparent. 

8. When we stop the CRYO we see the sample half cut as below.  

 

Guidance and Tips on CRYO 
• The larger the block the bigger the surface area vulnerable to the ambient air, if you want a bigger block ensure the 

room maintains a lower temperature this will aid in the overall cooling process. We recommend starting at a 
smaller sample size and increasing do not attempt a huge sample on the first ever attempt. 

• Debris, the system is prone to debris collecting on the sample, this is due to the ambient blade meeting the cooler 
surface of the block.  Debris will collect as it is melted, to solve this make sure blade contact time is limited.  

• Keeping sections, this one is a bit complicated. Due to the design of the system (the original HREM frame) it 
wasn’t designed to be a cryotome, so the current attachment is the best option for creating an ideal hybrid system 
without ruining the operation of standard HREM. In order to pull sections off the unit you’ll have to do this 
manually (or at least how we have achieved this): 

1. Set the unit to pause when you need a section. 
2. Get a can of cryo spray, spray the blade and slow the X stage. 
3. Press resume, spraying the cryo spray to stop the ambient air getting to the section. 
4. Get ready to transfer the sample as quickly as possible. 

• Temperatures are not an indication of sample temperature, this is because the sensors are just touching the 
surface of the cooler and are not inside the metal. So, use your own judgment as to temperatures. The cryo 
feedback sensor should range between -10 to -14 degrees when ready.  
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Setting Up Image Profiles (Imaging tab) 
Profiles are an easy way to manage the images per section. Each item in the list will be imaged during the experiment.  

For example, if I want to image two channels ‘gfp’ and ‘dapi’ I would add these two profiles only. During the experiment it 
will run these two profiles at each section. 

The selected image profile that you are editing is highlighted as below. 

 

Figure 22 Two Channel Example 

The profiles in the master control will be the ones that feature in the experiment. If you don’t want to run the 
sequence delete it. 

Each profile is selected in the master window, during this you can change the parameters for the setup:  

• Filter position  
• Light selection  
• Focus position  
• Camera settings  

Filter Position 

 

Figure 23 Filter Position. 

To control the filter changer, use the filter control. The filters names can be changed in the settings. 

however, should be set to the user’s configuration. To change the current experiment filter, select one of the other list box 
items with the desired filter name. 
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Light Position 

 

Figure 24 Light Position. 

Select the light you wish to use from the check boxes during a run. For advanced illumination systems use the up down 
controls to vary the intensity of the light source. 

The master light will not affect the experiment it simply allows you to switch on and off the lights like a toggle switch 
out of an experiment WITHOUT AFFECTING THE EXPERIMENT. If the light is selected it will run in the experiment. 
Treat the master as an overall switch, that the experiment will operate. 

Focus Position (If your system has a focus module) 

 

Figure 25 Focus example. 

The focus is used to make slight adjustments to the focus, not to be used as a coarse focus. The range of the focus will 
allow for compensation in different wavelengths when changing filters. The focus is fitted with an ‘Auto focus’ which 
iterates through a range to find the best position for the lens on the current image configuration  

Camera Settings  
Adjust the exposure, contrast for each image profile. 

 

Figure 26 Camera Settings 

Auto exposure should be turned off before starting an experiment it is designed to simply help get an image. 
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Please note most HREM cameras are monochrome, this is because they are more sensitive and better for 
fluorescence applications such as HREM. If you wish to add a colour to your image for channel differentiation, see 
below.  

Camera Operation Controls 

 

Figure 27 Camera operation controls. 

• Live - Sets the camera live for setting up before an experiment. This will be displayed in the ‘Live Resolution’ 
selected in the camera panel. In the above case 5496 x 3672. 

• Abort – Stops the current live feed, this may take a second to update so please be patient.  
• Shot – Acquires an example shot image using the ‘Shot Resolution’ drop down value.  
• Save – Perform the same function as shot but save the image, when pressed a dialog will open. It will save the 

image in the experiment format with tiff tags (if tiff tags has been selected). 
• Shot (with measuring tape) – saves an image with a ruler over it calibrated from the virtual graticule. 
• Reset – Resets the current image profiles settings (exposure time, gain etc). 

 Resolution 

 

Figure 28 Basic camera parameters. 

Channel (COLOUR CAMERAS ONLY, ELSE SELECT COLOUR) – if you have a colour camera this box will filter the image feed 
to the selected channel, if we select Red, the feed will only show the Red channel of the colour channel. If your camera is 
monochrome, which is more common, select the colour channel.  

• Mode – Jenoptik Cameras, if you have a Gryphax camera this will allow you to change the mode from 8,16 or 
colour images. 

• Mode – Basler Cameras, here you can apply a colour to the image as explained in the colour change section 
below, please read this for more details.  

• Live Resolution – The resolution the camera will perform in live mode, this resolution should be smaller than the 
highest resolution as a live stream of 20 megapixels can cause the UI to be a little unresponsive which will not 
help setup. 

• Shot Resolution – Pick the best resolution, this will be the resolution that is performed through an experiment.  
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Brightness + Exposure 

 

Figure 29 Brightness + Exposure 

• Exposure time – The camera exposure time. 
• Gain – The amount of gain the camera will perform. The smaller the better as this reduces noise. However, you do 

not want to have exposure times above 0.5-2 seconds. 
• Brightness (not available for Jenoptik cameras) – Digitally adjust camera brightness. 

Processing 

 

Figure 30 Processing 

These features are after processing techniques that will helpful to toggle while setting up the instrument.  

• Contrast – The camera contrast, this helps to enhance features. Use a negative contrast to help flatten the overall 
image illumination and bring out darker features.  

• Sharpness – Increases the defining features of the image but may increase salt and pepper noise.  
• Noise reduction – Use this function to remove the extra noise created by the sharpness filter and gain.  
• Invert Image – Inverts the entire LUT of the image. 
• Gamma (not available for Jenoptik cameras) – Adjust camera gamma. 
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Tools  

Histogram 

A histogram can be used to understand pixel spread to ensure a correct brightness value. The histogram can be enabled in 
the camera tab and will turn off when an experiment starts automatically to speed up the UI. Please be aware that high 
resolution images can cause a delay in image processing. 

Enabling Histogram 
To enable the histogram, go to the camera panel and select ‘Tools’ -> ‘Show Histogram’. 

 

Once selected the plot should then appear under the tools tab in the top left corner as below  

 

 

Advanced Parameters 

Auto Exposure 

 

Figure 31 Auto Exposure 

Auto exposure is not to be used during a run and should be switched off when not in use. The idea behind auto exposure is 
to help the user setup the instrument under varying conditions.  

• Use the check box to toggle the function on and off.  
• Use the brightness slider to adjust the intensity of the image. 
• During this operation the controls will disabled so they can sink with the real values. 
• Be sure to turn off the function after use.  

Colour Change (Mapping)  

If you wish to add a colour to your image for a fluorescence channel combination this can be easily done.  

While in the camera panel go to the mode combo box and there will be a selection of colours to choose from.  
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Figure 32 Colours for mapping. 

Below shows the camera in all of the LUT, you can select the colour and the monochrome image will be displayed as a 
colour image filling the channel of the colour image.  

  

Figure 33 Original Image 
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Camera Calibration  

 

Figure 34 Virtual Graticule Tab 

To perform a calibration, click on the calibrate button under the virtual graticule tab, then a image will be taken so be 
patient. 

• Place a physical graticule on the sample and focus. 
• Select a starting point with the left-hand mouse button. 
• Hover over the end point you wish to make and click the right-hand button. 
• In the dialog select the measurement value.  
• If you wish to export the images with the information, use the file formats TIF or TIFF. 

It also important to note that performing a stitch will overwrite this pixel data.  

 

Figure 35 Example camera calibration. 

Please note, the calibration is designed to work with FIJI and Dragonfly other products may need to be turned off and 
manually done. Uncheck the value below settings -> Tif/Tiff tag. 
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Adding a profile  
To add a profile, click add and then create a name and press enter. Use the drop down to select a AqExp or XML file from 
experiment, you can then load in all the profiles from this experiment. 

 

Removing a profile  
Select the profile to remove and click remove. 

 

Refreshing a Profile 
To refresh the profiles if something has gone wrong, such as a camera error. You will need to do this manually as the 
camera loads the profile information and a refresh is required. 

 

Updating a Name 

 

Figure 36 Updating an image profile name. 

To update a name, select the profile you want to change the name of. Once selected use the textbox under neath to type 
the new name, once happy press enter or ‘Update Name’. 

 

 

Setting Up Another Windows User to Run Optical HREM  
Use this if you wish to store all settings without using any Administrator needed access such as the program data folder. 

Creating a Copy of Acquire Settings 
Before setting up a new user create a copy of the configuration file and the experiment file as these can go wrong and is 
good to have a backup here.  

HREM uses two file types, one is saved to a shared folder under program data, this controls experiment parameters (the 
light selected, filter selected etc), this file has the extension AqExp. The other controls the machines setup (the amount of 
filters, type of filter wheel etc), this has the extension .AqConfig. The current experiment file will be universally shared 
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between users, but the configuration file will have to be set up manually for each user. The current experiment file will be 
found in:  

C:/ProgramData/Indigo Scientific/OHREM Acquire/Experiment File.xml 

1. To setup a new user (Older than ver 1.3.7): 1. Save the current configuration file in the working application. Copy 
this file to a shared location. 

 

Figure 37 Save Configuration 

2. Once saved go to the users account. When logged on double click on the saved configuration file, this will load the 
application with the required settings. The logo may appear different to the image below depending on the 
version, the newest version of the software will appear as below. 

 

Figure 38 Example Configuration File 

3. Once complete exit OHREM Acquire and come back in to ensure the settings are correct. 

 

 

 

 

 

 

 

 

Setting Up a User with No Admin Rights 
1. Save the current configuration file in the working application. Copy this file to a shared location. 
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2. Once saved go to the users account. Now use the icon found on the desktop labelled ‘Configure Acquire Settings 
(SETUP ONLY)’. Icon may vary on version of software, look for the text not icon. This will open a dialog. 

 

Figure 39 Setup Icon (Icon may vary) 

3. When the dialog opens seen as below select the experiment file, Instrument Config and the shared save folder as 
seen in the image below. Then click apply and wait for the application to load. Once loaded, exit the software and 
open the software using the normal icon. 

 

Figure 40 Acquire Configurator 
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Running the Instrument  

Prepare  

 

Figure 41 Prepare section. 

A Prepare is used to trim a block a certain amount before capture. The prepare performs the experiment without entering 
an experiment.  

1. Set the number of sections you wish trim. 
2. Set the section size in microns.  
3. Press the ‘prepare’ button. 
4. While in prepare use the abort button to stop the process.  

Some important notes: 

• Prepare cannot be paused and can only be started again after aborting. 
• A prepare will not image a sample.  
• An output log will appear with some data, this is mainly for debugging and not for the user to attempt to 

interpret. Data for the user is kept in the experiment file during an experiment not a prepare. 
• Progress will be shown while running. 
• The number next to the step size in brackets (0.93um) is the expected step size of the instrument, this is 

down the age and model of the instrument as to the accuracy of this number. 

Experiment  
Settings  

Directory/Saving  

 

Figure 42 Directory/Saving Info 

These settings change the settings involved in saving the experiment. 

• Directory – The overall directory to save in  
• Experiment name – The name of the experiment.  
• Save type – The image format to save in (use TIF or TIFF for saving graticule dimensions) 
• Notes – The notes to save in the experiment file.  
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NOTE: 12 BIT/14 BIT/16 Bit images will only be saved in TIF and TIFF mode. If a camera is 12 or 14 bit the image will be 
saved as a 16-bit image. This is because most software packages prefer to handle 8/16-bit images, this does mean 
your image may be black or the intensity is multiplied to meet the values. Jenoptik Gryphax cameras will be 
wrapped in 16 Bits, Basler balanced to 16 bits. 

Z Axis Settings 

Change the step size, sections or sample height by using the scroll wheel when over the up down. You can also use the 
buttons to the right. 

 

Figure 43 Z Axis Settings 

• Step Size – The step size to be completed during an experiment. Next to the step size is the expected output for 
the selected step size, this is dependent on the controller of the system. 

• Sections – Number of Sections to be completed. 
• Sample Height – Height of the entire sample.  

Auto Pause 

 

Figure 44 Auto pause feature. 

Use the auto pause feature to stop the instrument after a certain number of sections so that you can capture sections. 
Perform a specific routine at a specific point.  

• Enable Pause Every – Will stop the machine every x number of sections. In this case it will stop every 50 so 
50,100,150… 

• Enable Pause Once – will stop the machine only once at the specified number. 
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Misc 

 

Figure 45 Misc Experiment Settings 

• Auto Rotate Image Profiles – After each section the image profiles will flip, so they will start off Profile 1, Profile 2 
then on the next section go Profile 2, Profile 1. This is save time.  

• Auto Rotate Stitch Pattern – Performs similar to the above but reverses the stitch pattern every section, please 
note due to slight inconsistencies reversing the pattern will result in different transform. 

• Move Filter During Run – Allows the filter off during a run, if you do not wish to use more than one filter channel this 
saves time. (SUGGESTED ON) 

• Use stitching if available – Will stitch images if there is an AqStitch file present. 
• Image Webcam Each Section – Enables an image to be saved from a webcam feed to an AVI file for a movie, if 

there is a webcam connected. 

Before Running an Experiment 
1. Ensure the drive has enough space you are storing to, not a cloud drive, USB drive. You can do these but they are 

unpredictable. IT IS YOUR RESPONSIBILITY TO ENSURE THERE WILL BE ENOUGH DISK SPACE. 
2. Ensure the path does not contain illegal characters such as ? or #. 
3. Ensure there are no files in the experiment file name, use the recycle files button to do this. 

 

How are Experiments Stored? 
This depends on the type of experiment. 

For only 1 Image profile with just 1 XY position (or no XY) 

The output will be saved as your experiment name for example ‘ExperimentName_0_’, each file will be labelled as such 
‘ExperimentName_0_00000.jpg’ inside of the chosen directory. 

For more than 1 image profile 

The output will be saved under your experiment file ‘ExperimentName’ in this folder there will be each profile name. Lets 
say we have two channels ‘Channel 1_’ and ‘Channel 2_’,  

ExperimentName -> Channel 1_ -> Channel 1_00000.tif 

ExperimentName -> Channel 2_ -> Channel 2_00000.tif 

 

For more than one XY position and more than one channel: 

ExperimentName -> Channel 1_ -> Channel 1_00000 -> Channel 1_00000.tif 

ExperimentName -> Channel 2_ -> Channel 2_00000 -> Channel 2_00000.tif 
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Running  

 

Figure 46 Experiment Controls 

To run an experiment once you have setup the experiment in the tabs. Press ‘Run Experiment’. Before an experiment the 
software will ensure there are no issues before running and let you know if there is a problem. 

While in an experiment you can pause the experiment or abort the experiment. 

 

 

 

 

 

 

Variations of Run Experiment 
To open the options to run an experiment click the arrow on the right of the button. 

 

Figure 47 Options for run experiment. 

 

There are 3 Options for an experiment: 

1. Run Experiment – This will start the experiment from the beginning as usual. 
2. Run Without Initial Z Movement – Run the experiment without moving the Z on the first section, this can help 

capture all the data if you are already at the sample. 
3. Run at a Specific Point – This function allows you to pick up where you left off in an experiment in the event of an 

error or PC outage. Clicking this button will prompt a dialog as below. 
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Figure 48 Run at a Specific Point 

Select the section number you wish to start from i.e. I would like to start from section 600, put in the number box 600. You 
can then choose to move the Z for the first section, click ok. 

 

Analytics and Output 
In Experiment Analytics 

 

Figure 49 In Experiment Analytics 

While running in prepare or experiment a group box will appear with all the current information for sectioning, estimated 
time, current thickness average and percentage.  

Disk Space 

 

Figure 50 Disk Space in Computer 

Disk space is monitored under ‘Other’ in the same experiment analytics display. 

This function can be turned off by going to settings -> Experiment -> Enable disk check per section when in an 
experiment/prepare. 
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Figure 51 Disk Check Settings 

 

 

 

 

 

Z Section Adjustment  

 

Figure 52 Z Sections Adjustment 

Use this function to change the amount of sections in the experiment without pausing or aborting the experiment. Put in 
the amount of sections required overall and click ‘Set Sections’ then the experiment will update once the current section is 
completed.  

Output Log 

The output log shows the current information output and errors, this will appear in an experiment.  

If an error occurs it will appear in this window as [error], general information for the user will appear as [info]. Below is a 
screenshot of an output seen while running an experiment.

 

Figure 53 Output during an experiment. 

Output file 

An experiment will output a text file in the directory, that outputs each section and a summary of the experiment.  

The exported file will show the image profiles with its settings. It will also show the pixels per micron in the output file. 
Exported will be the pixel size (in microns) and the pixels per micron. 

The output file also exports section information so is regularly updated during an experiment after every section.  

• Section -> Current section. 
• Encoder Height -> Current retrieved height from the encoder device. 
• Section Thickness -> Thickness of the section cut. 
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• Average Section Thickness -> Rolling averaged thickness of all the sections. 

 

Figure 54 Example Output txt file. 

PLEASE NOTE THE ENCODER IS ONLY ACCURATE TO 0.5 Microns. If the encoder is out of range it will not produce 
any value and section thickness is 0, this does not mean the instrument is not working, simply the encoder has gone 
beyond the maximum/minimum amount.  

 

The output file can be found as above and is called “Experiment Summary Example Experiment”. 

Storage 

As of version 1.7.0 the computer storage will be output to the log file as follows: 

 

Working out voxel size 
Voxel size can be calculated as the width, height and depth of the data set. 

In the above case the voxel size would be: 

Pixel size (X/Y) = 0.5935 

Pixels size (Z Average) = 0.87 
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Voxel Dimensions (microns)= 0.0005935 x 0.0005935 x 0.00087 

Voxel Dimensions (mm)= 0.5935 x 0.5935 x 0.87 

Most 3D packages require this in millimetres, so these values need to be divided by 1000 as millimetres are a 
thousand times larger than microns.  

 

Webcam  
A webcam can be mounted to the system and visualised in the acquire software. 

Setting Up and Enabling Webcam 

 

Figure 55 Webcam Settings 

Go to Settings Tab -> Webcam.  

• Enable the ‘Allow Connection’ Check button. 
• The webcam name must be found to do this go to device manager in windows by typing device manager into the 

search bar. 
• Once in device manager find the webcam as below. 

 
• Type in the name into the ‘Webcam Device Name’. 
• Now type in the save location for the mp4 file output. 
• If you plan on exporting the video, choose an FPS 20-30 is common value. 
• Restart the software. 

IF YOUR WEBCAM DOES NOT CONNECT ON STARUP, RESTART THE SOFTWARE. 

Viewing Camera 

 

Figure 56 Webcam Tab 

Once the webcam is enabled, the webcam tab will appear, click on this to view the camera. When the tab is not selected 
the image will not update to try and increase GUI interactivity.  
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Capturing a Video 
During an experiment you can capture one image per section from the webcam to store in a folder, this can help 
troubleshoot or simply provide some fun footage of the HREM at work.  

To enable the video, go to Misc -> Image Webcam Each Section. 

 

Figure 57 Enabling Webcam Video 

As long as the camera is connected the video should be created. 

NOTE: Please note that the file may act corrupt until it has finished being saved. On top of this the file will be 
overwritten when the user selects to run an experiment again. 
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Experiment Files 
Experiment files allow you to create experiments and store the parameters such as image profile setups. These are called 
AqExp files. 

Loading AqExp Files (or .xml) 

 

Figure 58 Loading Experiment File 

To load an AqExp file go to File -> Load -> Experiment File. These files can also be XML type, this is how they are saved in 
the experiment folder. 

Save AqExp Files 

 

Figure 59 Saving Experiment File 

To AqExp file go to File -> Save Experiment File As 
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Application Settings 
WARNING: DO NOT CHANGE ANY SETTING WITHOUT KNOWING WHAT IT DOES. If a setting is not present below it is 
not supposed to be modified by a user and we would advise contacting us before changing it. 

Camera - General 

 

These settings are the shared settings for the camera, they contain some settings for modifying the experience or nature of 
the camera. 

• Auto Brightness Max Exposure – The maximum exposure the camera can achieve when in auto exposure mode.  
• Auto Brightness Max Gain – The maximum gain the camera can operate at when in live mode.  
• Multi-capture – if the multi-image profile tab is present (SUGGESTED ON). 
• Take shot on live feed abort – Captures an image on the camera aborting when not in an experiment (SUGGESTED 

OFF). 
• Take Shot on Image Profile Change – Captures an image when the image profile is changes (SUGGESTED ON). 
• Pre Capture Stabilisation Time – The time before any image is captured, if using an XY this must be set to allow the 

components to stop.  
• After Capture Stabilisation Time – The time after a shot is taken before the capture sequence ends (SUGGESTED 

OFF). 
• UI Mirror Image Horizontal – Mirrors the image Horizontally. 
• UI Mirror Image Vertical – Mirrors the image feed Vertically. 
• Rotation – Rotates the camera feed to the UI. 
• Camera Type – The brand of camera you have (DO NOT MODIFY). 
• In Experiment Image Resize – To help make the UI easier to use you can resize the images being displayed. 

Tif/Tiff Tag 

 

The Export TIF/TIFF Tag Measurement option will enable or disable the images being exported with tags on when saving as 
TIF/TIFF. 
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Light  

 

Control the light and the amount of channels that appear, generally we will set these up on installation to match your 
illumination. But feel free to change the names and colours. DO NOT TOUCH THE TYPE PARAMETER. 

Filter Illumination/Excitation 

 

 

These items control the filter names and colours (software only), you change these and enable any that you like. DO NOT 
CHANGE THE TYPE. 
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X Stage 

 

WARNING: Editing these settings will change the blade functionality, be cautious. 

• Step size – the number of steps per 1mm (usually this is around 200 for older models, new models will vary). 
• Available decimal places – The number of decimals to show in the UI (SUGGESTED 0). 
• Position Limit – The limit in mm for the stage, this will stop the Z and throw an error if out of range.  
• Max Speed Limit – The maximum speed the UI will let the user go. (NUMBERS WILL VARY) 
• Min Speed Limit – The minimum speed the UI will let the user go. (NUMBERS WILL VARY) 
• Torque – The torque the motor will achieve (THIS IS ONLY FOR OLDER HREM REVISIONS). 
• Acceleration – The acceleration of the blade (NUMBERS WILL VARY). 
• Home Speed – Speed the motors origin at, suggested these numbers are lower. 
• Origin Acceleration – Acceleration the motor returns at.  
• Origin offset – DO NOT MODIFY. 
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Z Stage 

 

Most of these settings are not to be edited by the user the only setting to change is the ‘Z Stage Relative Only in 
Experiment’. 

This is designed to be used with controllers when they are not homed after every power cycle. This cannot be used with 
compound versions of the instrument. 

Virtual Graticule/Calibration 

 

• Allow Graticule During Live Feed – Allows the graticule to be taken and imaged while in live mode. (SUGGESTED 
OFF). This will also stop the graticule from being displayed in live mode. 

• Show Reminder to Calibrate Images – This will prompt the user to perform a graticule. 
• Virtual Graticule Colour – The colour the overlay graticule will be displayed as. 

 

Webcam 
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This function allows you to use a webcam in Acquire, in future this will image one each section into an AVI. For now it 
simply allows you to capture a feed in the software. If you wish to disable this uncheck ‘Allow Connection’. 

UI 

 

• Image Viewer Back Colour – Change the background of the viewer from black to white.  
• Enable Image Overlay – Enables an overlay on the image space indicating information such as exposure, gain, 

filter selection.  
• Overlay Image Text Colour – Colour of the text overlay. 

Saving and Admin Tools 

 

We would suggest leaving these settings but can be used. The reason for this setting is to allow the user to save the data to 
a path that isn’t the program data folder, in the event IT do not allow this. 

• Temp Directory – The directory to store all the data. 
• Open Exit Dialog Checker – This opens another piece of software that ensures the application closes. 

Experiment 

 

• Control the wait before the camera captures in ms (SUGGESTED 0-500) 
• Enable disk check per section when in an experiment/prepare – Will report disk space in the experiment log 

(SUGGESTED ON) 
• Save images in sub folder always – When the software only has 1 image profile and no XY this option will tell the 

experiment to save the data in a subfolder to help with external scripts.  
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Histogram 
This set of functions control the image histogram displayed under the ‘tools’ menu. 

 

• Fill in histogram area – Fills in the area under the histogram (this may decrease frame rate) 
• Histogram Buffer Time (ms) – How long a new call to create a histogram should take based on when the previous 

call was made (SUGGESTED – 500-2500ms based on PC) 
• Histogram Bins – Number of bins the histogram has, lower numbers will not give enough information, too higher a 

number will decrease frame rates 
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Updating Acquire 
Acquire is a simple windows application that is updated by following the procedure below (You will need to be a system 
administrator to perform this): 

1. Close acquire if already open. 
2. Uninstall the original Acquire software by using the usual control panel -> uninstall a program  
3. Locate ‘OHREM Acquire’ and uninstall. 

 
4. Follow the prompts to remove the program.  
5. Download the latest acquire program (you can simply ask us for any progress on updates or what version to 

install), you can view all the downloads here: HREM Download Page | Indigo Scientific (indigo-scientific.co.uk) 
6. Click the latest file and this will download the ZIP folder 

 
7. Follow the prompts to install the file. 

Entering Engineering Mode in Acquire 
Engineering mode gives you access to settings that otherwise you would not see as a standard user, it will not change the 
way the instrument runs. 

1. Load into acquire. 
2. Go to the ‘Settings’ tab and then the ‘Engineering Tools’ accordion item. Expand the accordion item by clicking the 

arrow.  
3. Check the ‘Engineering Mode’ checkbox. 

https://www.indigo-scientific.co.uk/hremdownloads
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4. A window will pop up, put in your name so we have a log of who has logged in. The password is IndigoOHREM 

 

5. Click ‘Login’. Now you are in engineering mode. 

Aligning Images in Acquire with Overlay 
It may be that your experiment failed because the power went out or your PC decided to update. We have made it easy to 
align a sample by allowing you to overlay an image with the current feed from the camera. This will allow you to align the 
images perfectly. 

1. Go to Tools -> Camera -> Add Image Overlay 
2. Select the last image taken of the block on the last run in the dialog. 
3. Start the live feed of the camera, the overlayed image will have 50% transparency. 
4. Now you can align the X and Y and camera rotation to match the images. When matched they should appear clear. 
5. To turn of the overlay, Go to Tools -> Camera -> Remove Image Overlay 

 

Acquire Q and A 

Virtual Graticule or Dimensions Not Correct 
There are a few things you need to check: 

1) Are the units correct, the output log specifies microns. Millimetres are 1000x greater than microns. 
2) Is your software compatible, some software uses different tiff tag units which is not known by us. Generally, TIF 

tags should be easily imported without trouble. In this case it is suggested you turn off the tiff tag export. Or simply 
resize the calibration in fiji. As well as check all settings are correct in your designated software packages.  

Another source of this error is older experiment field mixed with new, to fix this clear the image profiles by deleting the 
graticule values. Go to Tools -> Image Profiles -> Delete All Virtual Calibrations  

 

Figure 60 Deletion of virtual graticule dimensions 
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How to stop windows updates in Windows 11 
1) Type ‘Windows Update Settings’ in the search bar. 
2) Go to the pause updates and do this every 5 week, you shouldn’t block updates as they are always needed but 

simply pause when the instrument is in use.  

 

Power Saving  
Power saving is a hard item to control as windows updates, IT visits and all kind of reasons can cause it to revert. But every 
now and then it is worth checking it isn’t causing a problem.  

1) Type ‘Edit Power Plan’ in the search bar.  
2) Click ‘Change Advanced Power Settings’ 
3) Change the USB selected suspend. 

4) Change the link power state management. 

5) Click Apply then OK. 
6) Change the settings to the following 

 
7) Then click ‘Save Changes’. 

What are Image Profiles? 
Image profiles are simply a way of taking multiple images per section in different wavelengths and camera configurations.  

Why a monochrome camera for imaging? 
Monochrome cameras are not a cheap alternative, they are a better and more expensive alternative. We provide 
monochrome cameras as HREM only images one filter set at a time, and for fluorescence applications a monochrome 
camera provides a greater sensitivity and quality. If you wish to apply a colour you can in the mode, drop down. 
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Connecting Instrument on Software Startup 
To connect to the instrument on startup make sure you are logged into engineering mode as explained previously to show 
the communication settings item. 

1) Go to settings tab. 
2) Go to ‘Communication Settings’ and click ‘Connect on Startup’ 

 
3) Now click apply in the settings tab and exit the software. 

Removing Filter from Setup or Disabling 
If you wish to remove a filter from the software, follow the following steps: 

1) With the filter connected to the software move the filter slider/wheel to the wanted position in acquire. 
2) Without touching any other part of the software do the following (NOTE: Names of filters and some items may not 

be available in older versions of the software, but this is still valid): 
a. Go to the filter tab (depending on the system you may have an emission filter and excitation filter or 

simply just one of these). Your screen below will look like the following in the settings tab: 
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b. The above shows both enabled, to disable a filter click the ‘Use Excitation Filter Set’ or the ‘Use Emission 
Filter Set’ so the checkboxes appear like below, no need to alter any other settings: 

 
c. Exit the software and re-open. 

For a soft ‘no use’ the filter, i.e. forcing the system to ignore the filter during a run but still connect to it(you do not plan on 
moving the filter), go to the ‘Misc’ experiment settings panel and unselect ‘Move Filter During Run’. 

 

 

 

 

Experiment Run-through with the Micro 
This is a very brief quick start guide to using the Micro, some elements of this guide appear above in much greater detail 
such as rotating the FOV and virtual calibration. 

Setup  
Loading a sample 

1. Place the trimmed sample into the empty sample holder, this can be done on the machine or by removing the 
holder. 
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2. Load the sample into the empty holder and tighten the sample retaining screws as seen below (2x M4 Screws), 
until the sample is tightened. If there is no movement please do the opposite of step 3. and loosen the retaining 
screws. 

 

 

 

 

 

 

 

 

 

 

 

3. Tighten the fastening plate on the top of the sample holder by fastening the screws highlighted on the top of the 
system. (4x M4). 



Page 62 of 91 
 

 

 

4. Use the Z stage buttons, small, medium and large to get the sample as close as possible to the blade, without 
touching. Here we used the paper trick described earlier between the sample and blade. Put the X stage into the 
middle of the sample for better reference.  
 
Look for visible light between the sample and blade, move up the Z by 1-2mm then when you can fit the paper just 
between use the medium move to trap the paper. Rock the paper back and forth until you feel it catch while 
moving the Z up, then when you feel it catch move down the Z by 20 microns. 

 
 

5. Perform one pass of the X stage to ensure clearance is ok. 
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Prepare  
1. Run the prepare function until the system is sectioning complete sections, once the whole block is level you can 

now setup for an experiment. 
2. To get the alignment of the sample perfect, you will need to rotate the microscope around the centre pole. Undo 

the block holding knob situated at the back of the stand. 

 

 

3. Gently place both hands on the front of the microscope and now you can lightly move the microscope left and 
right with your hands. It may help to apply some upward force to move the whole assembly. Alternatively you can 
move the sample into the fileld by undoing the sample holder using the bottom 3 screws and moving it left and 
right. If you move the sample in any way you must repeat the Z setup for cutting. Get the image as close to the 
centre of field as possible, you can rotate the camera to also help get maximum resolution. 

4. Now focus on the top of your sample using the fine/coarse focus knobs on the instrument. The larger wheel for 
coarse movements, finer wheel for little adjustments. 

 

 

 



Page 64 of 91 
 

5. Locate the screw that holds the camera in place as seen in the image below, it is just below the whole camera 
tube lens (large black tube). Undo this with an M4 hex key, only so the tube can be rotated, do not loosen entirely. 

 

6. Rotate the tube lens under the camera, this will move the whole assembly with your hands. 

 

7. Once the camera is rotated, lock the tube lens by tightening the screw that holds the assembly in place. 
8. Now you can zoom in to fit the field and re-focus. 
9. Adjust the camera exposure and processing settings for a good image. 
10. Place a graticule on top of the sample and focus. 
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11. Press calibrate in the imaging tab and wait for it to take a picture of the graticule. 

 

12. Measure the region visible, press the left hand mouse button to select the starting point and the right hand mouse 
button for the end point. 

13. Refocus the sample. 

Experiment  
• Set the experiment file path as well as the experiment name (no spaces at the end of the name). 

 

• Set the number of sections and step size in the ‘Z Axis Settings’ tab. 

 

• Press Run Experiment 
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Acquire Version History 

1.6.18 
A minor release with the following fixes: 

• Fixed certain encoders timing out when there is no/little signal from the encoder. Now the encoder will readout 
regardless. 

• Added different colour filters for monochrome B cameras so multi-fluorescence channels can be separated in 
colour. 

• Added the ability to not write dimensions on TIF/TIFF images. 

1.7.0 
This new release incorporates some new features for users to help make setting up and monitoring easier: 

• Added webcam and ability to control FPS, added the option to save feed to video file. 
• Fixed specific encoder (ND280) from hanging on pause or resume.  
• Allowed users to delete all virtual graticule calibrations in the event of a resolution change.  
• Added ability to move X halfway between end and home positions.  
• Added gamma and brightness control to basler cameras. 
• Added hard drive space monitor during an experiment. 
• Added 12-bit basler images. 
• Snap images now save to experiment directory. 

1.7.1 
• Added a function to allow Z devices to move in relative mode only. 
• Force abortion when camera is requested to take shot when in live mode. 
• Rounded disk storage percentage. 

1.8.0 
• Added structured illumination hardware to software and basic algorithm implementation. 
• Added live feed image combination for structured light. 
• Overlay images now adjust resolution. 
• Z Stage can now run in relative only mode. 

1.8.1 
• Added structured illumination live mode. 

1.8.2 
• Basler camera updates. 
• Updates to structured illumination hardware. 
• Added colour indicators for filters. 

1.8.4 
• Updates to structured illumination and algorithm. 

1.8.5 
• Added ability to save a ruler overlayed image onto the screen. 
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1.8.6 
• Added SIM tab. 
• Added noise reduction before and after sim. 

1.8.7 
• Added ability to turn on or off noise. 

1.8.8 
• Added Fourier suppression. 
• Further SIM noise suppression. 

1.8.9 
• SIM Saving updates. 

1.8.10 
• Created Fourier viewer. 
• SIM images save as multi-page TIF. 

1.8.11 
• Removed SIM imaging sharpening. 

1.8.12 
• SIM Processing window for before and after. 

1.8.13 
• Ability to turn off Fourier removal. 

1.8.14 
• Fixed Fourier viewer load image problem. 

1.8.15 
• Z height now does not need button change. 
• Added SIM settle time. 

1.8.17 
• Adapted SIM for consistent illumination. 
• Removed option to change UI colour, decreasing loading times. 
• Made Z up down into double text boxes to stop conflicts. 

1.8.18 
• Image calibration tab defaults to microns. 

1.8.19 
• Fixed blue low contrast text in output log window. 

1.8.20 
• Fixed Z controls to make easier for the user. 
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• Added open experiment folder menu button. 

1.8.21 
• Fixed Z sections not saving. 

1.8.22  
• Fixed structured light tab popping up. 

1.9.0 
• Added Z section change. 
• Added FPS limiter in Basler cameras. 
• Added reset button to camera profile. 
• Added Basler camera retry when grab fails, often present when USB interface runs slow due to attached items.  
• Changed camera tab UI for better organisation. 
• Added home buttons for X and XY stage in connection window. 

1.9.1 
• Added some missing dependencies that caused error on older machines. 

1.9.2 
• Added import for image profiles. 

1.9.3 
• Basler cameras now supports RGB8 colour modes and filtering (if the camera is colour). 
• Basler cameras now set modes to long exposure mode as standard, reducing overall camera temperature 
• Added voxel size to experiment output. 

1.9.4 
• Fixed light master toggle switch being unresponsive. 

1.9.5 
• Added hardware support for older CM motors called ‘CMV2’. 
• Fixed camera ‘connected’ label being cropped on startup. 

1.9.6 
• Added timer for in position check for CMV2 motors. 

1.10.0 
• Stitching now performed based on magnification. 
• Added the UI elements for fixed stitching. 

1.10.1/1.10.2 
• CMV2 hardware communication altered for reduced conversation. 

 

1.10.3 
• Added image histogram and control parameters 
• Added ability for a single image profile to be saved inside a folder. 
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TIFF File Reader  
The TIFF file reader is a simple TIFF/TIF viewer which is capable of displaying multi page TIF images or single images with 
the ability to pan and zoom.  

Loading an Image 
TIFF file viewer, once installed, should open by default when clicking on a TIF/TIFF image. You can also open the image by 
opening the software using the icon found in the start menu under ‘Indigo Scientific’ or simply clicking on the if the file type 
is associated with the tiff reader. 

 

Figure 61 Tiff Reader Icon 

Click load image and select the TIF/TIFF image. 

 

Viewing a SIMM Image 
You can view the SIMM images after loading the stack by using the boxes in the SIMM Image tab.  

• RMS Image – the calculated complex image. 
• Combined image – the 3 phases combined. 
• Phase 1,2,3 – individually captured phases. 

 

Figure 62 View of SIM Image 

Viewing a Standard TIF Image 
Once open in the software use the left button and hold and drag the mouse. Use the scroll wheel to zoom in and out.  
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Figure 63 Single TIF Image 

Creating a SIM TIF Stack 
Acquire does this automatically but if you want to do this manually. 

• Click the ‘Create Sim Image (4 Image Stack)’ under the ‘Load’ menu item tab. 

 

• Select 3 images, containing the 3 RAW sim images 

 

• Then follow the prompts to save the image. 

TIFF Reader Version History 

1.0.0 
Initial Release. 
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Post Processing and 3D Viewing  

 

 

Processing HREM images can be split into clear steps  

• Capture  
• Processing 
• Visualisation 

Capture 
Capturing HREM images as seen in the software manual has many parameters, here you will decide if you will perform 
standard HREM (negative fluorescence) or positive fluorescence. You can use the inbuilt adjustments to alter the images 
prior to capture such as contrast, exposure and gamma. 

Processing 
It is worth noting that processing is a users decision, you will need to create your own way of doing this but we will give you 
a start. We are aiming to create a black background image with a white sample, replicating that of a micro-ct image. 
Having a white background and a black sample will produce a white block with no sample.  

Look at it this way, the black in the 3D software will appear as completely transparent, white completely opaque. 

(It is worth noting the 3D viewer performs some basic steps for fast visualisation). 

We often use ImageJ/Fiji to pre-process images.  
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Loading an Image Stack 
- Open Fiji/ImageJ 
- Select File -> Import -> Image Sequence 

- A Window will pop up like the below, this aids in loading a stack. There a are some parameters that will help load 
images. 

o Leave start at 0 (this is where the stack starts). 
o Count (Number of images in the stack). 
o Step (If you want to skip images 1=all images, 2=every other image, 3=every third image….) 
o Scale (Here you can rescale image 50% will be half the image size). 

 

- Press ok to load the images. 
- Now the image stack will appear use the middle mouse wheel to scroll through the images.  
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Image Inversion 
Here we invert the LUT so that the background is black and the foreground is white. 

 

 

Contrast Enhancements 
Now we can enhance the contrast between background and sample as well as inside the sample. The window/levelling 
tool further remove background information.  
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Removal of Debris 
Here we remove debris from individual sections, such as floating sections in the corner that cause intensity spikes. Simply 
use the circle or rectangle drawing tool, select the area and click delete to set the pixels in that area to black. Do this for 
each section, although intensive it will create great 3Ds. 

Here we selected an area using the left hand button, we just use the centre of the image as an example. When you have 
selected the area, press delete on the keyboard. 

 

Deletion of Sections  
Here we delete sections that contain debris that covers the image, such as a section attaching to the sample. The reason 
why is that when creating the volume this will impact the view. You can duplicate an image to replace the deleted image or 
interpolate, this won’t affect your results too much as long as you don’t remove a lot of images. 

Simply go to Image -> Stacks -> Delete Slice, while on the selected slice to delete. 
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Cropping  
Cropping is an easy way to reduce image size without reducing resolution. 

• Select the rectangle tool. 
• Draw round your sample, use the scroll wheel to see if any of the sample goes outside of the rectangles 
• Then press Image -> Crop. 

 

Resizing  
This is important and applies to any method, this is based on your PC specifications. Often software moves images into 
the VRAM in one way or another, as HREM image stacks can run up to GBs it is best you resize images.  

We recommend saving the whole stack at 100% and at a workable resolution for 3D (20-30%), you can always up this if you 
have a super PC.  

 

• Go to Image -> Adjust -> Size. 
• Resize the width and height and select ok. 
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Exporting  
Now export your stack to a folder to be used.  

• Go to File -> Save As -> Image Sequence. 

 

• Set the parameters and click ‘Ok’. 

 

• Wait for the images to save. 

 

 

 

Helpful Notes and Troubleshooting for Processing  
• Remember to keep track of resizing, your voxel size will change. As well as if you skip images, but not if you crop. If 

you calibrated the image, the resize should take into account this. 
• Z Resolution is not stored in TIF/TIFF files (at the moment). 
• Use the average section thickness as the Z Voxel Size. 
• If you are unsure, voxel size is a 3D measurement comprising of pixel width, pixel height and pixel depth. These in 

3D software are usually in microns or millimetres. For microns divide by 1000, for millimetres multiply by 1000.  

Examples of pixel size calculations  

Example 1 (Image Resizing) 

Resize to 30% of original value, if you have the values calibrated Fiji will calculate the below for you. 
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Original Voxel Size: X=3.1um Y=3.1um Z=2.65um 

Original Image Size: X=5000 pixels Y=3000 pixels  

Original Image Size(mm): X=15.5 Y=9.3 

Because you are effectively decreasing the number of pixels per um your X,Y values will increase not decrease. 

Resultant Voxel Size: X=10.3333um Y=10.3333um Z=2.65um 

Resultant Image Size: X=1500 pixels Y=900 pixels  

Resultant Image Size(mm): X=15.5 Y=9.3 

Example 2 (Image Skipping) 

Here we skip images, without changing the X and Y values. Skipping as stated above is when we skip every nth section thus 
reducing the Z resolution. In this example set the increment to 3 so we will have a 3rd of the resolution. 

Original Voxel Size: X=3.1um Y=3.1um Z=4.2um 

Now we skip every third image, effectively decreasing the resolution by a third. 

Original Voxel Size: X=3.1um Y=3.1um Z=12.6um 

Calculating Image Dimensions 
Image dimensions are calculated based on the user’s  

virtual graticule (or normal picture of a graticule) and the Z step size. First of all it is important to understand that in the 3D 
world we work in ‘Voxels’ these are basically a 3D pixel, in our case we just want to know how big this voxel is to tell the 
software.  

Before running an experiment, you will have to either take a picture with a graticule on the sample or perform a virtual 
graticule to get the sample dimensions. 

1) Find the experiment folder and locate the summary file.  
2) To get the Z voxel size go to the bottom of the experiment summary file: 

 

 Take the last sections average section thickness in the above case 0.99um, this is the Z depth of the voxel. 

3) For the XY voxel dimensions the user should have these values in the experiment summary or by physically taking 
a graticule image. If a virtual graticule was completed take the values below from the experiment summary file. 
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In this case the X/Y voxel size will be 5um. The X and Y voxel size for HREM will always be identical.  

 

If you have used a graticule image, you will need to load this into something like Fiji and measure the graticule. 

 

 

 

 

 

Dragonfly Volume Viewer 

Setup 
Load images into the viewer by going to: 

• File -> Load Image Files 

 

• Select the folder containing the image stacks 
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• Now your images are loaded into the software, press the ‘next’ button to continue the process. 

 

 

• Now you will reach a settings page, this is important for imaging.  

 

Image sampling -> Keep all as 1 (x,y,z,h) 

Image spacing -> X: (X Voxel Size), Y: (Y Voxel Size), Z: (Z Voxel Size) 
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Time steps -> T: 1 

Physical Conversion -> Offset:1, Slope: 1 

Transform -> Invert X Axis: False, Invert Y: Axis False, Invert Z Axis: False, Invert intensity: True(if image is not 
inverted) False(if image inverted). 

• Select Finish, now your images will be loaded. 

 

 

 

 

 

 

 

 

Creating a 3D View 
• Here you start with the images loaded in. The screen should look like below: 

 

• Right click on the image above and select ‘3D’ from the menu. It may take some time for this to process. 
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• The window will now update with a 3D 

 

• Use the left button to rotate the sample using the mouse. 
• In order to crop the view select the box as highlighted in red below. 
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• A box will appear, drag this to crop the view. 
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Translation Tools 

Row Column Stitch 
1) Go to the ‘startup’ tab and open the row-column stitch accordion item. 

 

2) Click ‘Browse’ and select the first image to align pick the higher number first in this case we pick image 
‘Exp_0002_0030’. 

 

3) Then we click to open a second dialog where we pick image ‘Exp_0002_0029’, then click open. 

 

 

4) Go to the create tab and drag the images to align them. 
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5) Put in the images per row, in this case its 9. This is simply the number of images before the sequence starts again. 
Then click ‘Create Row’, this will generate to columns to align. 

 

6) Let the software calculate rows. 
7) Align columns together the same.  
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8) Click ‘Create Whole Stitch’. 

 

 

9) Save result as an aqstitch for later use. 
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10) The result after some processing 
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Z Alignment  
Mis-alignment of the Z can happen when restarting the instrument, you can use our tool to fix any misaligned stacks. 

Before  

 

After 
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1) Find where your stack is not aligned. In this case it is clear: 

 

2) Go to setup and click on the z alignment tab and click ‘browse’. 

 

3) Select the two images to align and click open. 
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4) Drag the images to align as below: 

 

5) Click ‘apply to stack’  

 

6) Select the new folder to save images to and click save: 
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7) Wait for all the images to save: 

 

 


